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Top Tips
Place of publication (APA, 2010, p. 187)
Some references require you to enter the place/location of the publisher.
For multiple locations give the first one or if obvious, the location of the head office.
USA publishers: Give the city in full and the two letter abbreviation for the state:
New York, NY
Springfield, MA
Publishers outside the USA: Give the city in full and the country in full:
London, England:
Auckland, New Zealand

Author and publisher are the same (APA, 2010, p.203)
When author and publisher are identical, use the word "Author" as the publisher.
American Psychological Association. (2010). Publication manual of the American
Psychological Association. (6th ed.). Washington, DC: Author

Cite a source that you found in another source
If Allport's work is cited in Nicholson and you did not read Allport's work, list the Nicholson
reference in the reference list. In the text, use the following citation:
Allport's diary (as cited in Nicholson, 2003).
blah blah blah (Allport, 2000 cited in Nicholson, 2003)

No author and/or no date
If you cannot find the author place the title in the author position.
Use n.d. (no date) where no publication date is available.
Print version:
Merriam-Webster's collegiate dictionary (11th ed.). (n.d.). Springfield, MA: MerriamWebster.
For in-text citation, replace author with part, or if short, all of the title:
(Merriam-Webster's Collegiate Dictionary, 2005).
Electronic version:
Heuristic. (n.d.) In Merriam-Webster’s online dictionary (11thed.). Retrieved from
http://wwww.m-w.com/dictionary/heuristic
If the online version refers to a print edition, include the edition number after the title.

Long URLs
Use a soft return (Shift + Enter) to break long URLs before punctuation i.e., / or –

Two entries by same author, same date:
Allan, M. S. (1983a). Uses of video recording in an institution. In McGovern, J. (Ed.), Video
apps in English language teaching (pp. 83-93). London, England: Pergamon.
Allan, M. S. (1983b). Viewing comprehension with video. ELT Journal, 37(1), 23-27.
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Book (APA, 2010, p. 202)
If a DOI is assigned, use it as in the example below.

Author, A. A. (year of publication). Title of work. Location: Publisher.
Author, A. A. (year of publication). Title of work. Retrieved form http://www.xxxxxxx
Author, A. A. (year of publication). Title of work. doi:xxxxx
Author, A. A. (Ed.). (year of publication). Title of work. Location: Publisher.

Book with single author:
Reynolds, H. (2000). Black pioneers. Ringwood, Australia: Penguin.

Book with multiple authors:
Two to six authors:
Gilbert, R., & Gilbert, P. (1998). Masculinity. St. Leonards, Australia: Allen & Unwin.

More than six authors:
After the sixth author's name and initials, use et al. to indicate the remaining authors.

Book with editor(s):
Broinowski, A. (Ed.). (1990). ASEAN into the 1990s. London, England: Macmillan.
Nugent, S. L., & Shore, C. (Eds.). (1997). Anthropology. London, England: Pluto Press.

Book, author not known:
Longman dictionary of the English language. (1984). Harlow, England: Longman.

Book with author and editor:
Austen, J. (2005). Mansfield Park (J. Wiltshire, Ed.). Cambridge, England: Cambridge
University Press.

Book other than first edition:
Goudie, A. (2000). The human impact on the natural environment (5th ed.). Oxford,
England: Blackwell.

Book with more than one volume:
Corsini, R.J. (Ed.). (1994). Encyclopedia of psychology (4 vols). New York, NY: J. Wiley.
Topliss, H. (1985). Tom Roberts 1856 - 1931: A catalogue raisonne: Vol.2. Plates.
Melbourne, Australia: Oxford University Press.

Electronic-only book (APA, 2010, p. 203)
O’Keefe, E. (n.d.). Egoism & the crisis in Western values. Retrieved from http://www
.onlineoriginals.com/showitem.asp?itmeID=135
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Book with corporate author:
Institute of Financial Education. (1982). Managing personal funds. Chicago: Midwestern.
When the author and publisher are identical, use the word "Author" as the name of the
publisher. (APA, 2010, p.203)
American Psychological Association. (2010). Publication manual of the American
Psychological Association. (6th ed.). Author: Washington, DC.

Chapter or article in a book (APA, 2010, p. 204)
Fontana, A., & Frey, J. (1994). The art of science. In N. Denzin & Y. Lincoln (Eds.),
Handbook of qualitative research. (pp. 361-376). Thousand Oaks, CA: Sage.
Beck, W. (1994). Food processing. In D. Horton (Ed.), The encyclopaedia of Aboriginal
Australia: Vol. 1. (pp. 380-382). Canberra, Australia: Aboriginal Studies Press.

Electronic version of print book (APA, 2010, p. 203)
Shotton, M.A. (1989). Computer addiction? A study of computer dependency [DX Reader
version]. Retrieved from http://www.ebookstore.tandf.co.uk/html/index.asp
Shotton, M.A. (1989). Computer addiction? A study of computer dependency [DX Reader
version].doi:10.1036/0071393722

Dictionary, encyclopedia
Smith, A. D. (Ed.). (2000). Oxford dictionary of biochemistry and molecular biology (Rev.
ed.). New York, NY: Oxford University Press.
If an entry has no author listed, place the title in the author position.

Dictionary entry, encyclopedia article
Lumiansky, R. M. (1998). Chaucer. In The new encyclopaedia Britannica (Vol. 15, pp. 745748). Chicago, IL: Encyclopaedia Britannica.

Online dictionary, encyclopaedia
Yalowitz, S. (2005). Anomalous Monism. In E. N. Zalta (Ed.), The Stanford encyclopedia of
philosophy (Fall 2007 ed.). Retrieved from http://plato.stanford.edu/entries/

Notes for Journal Articles
DOI – Digital Object Identifier
A digital object identifier (doi) is a series of numbers and characters that identify online
journal articles (and some paper journal articles). Include the doi in your reference for
online and paper articles if it has one.
If you cannot see the doi (often top or bottom of title page) you can try to find one at
http://www.crossref.org/guestquery/ (you do not have to do this for paper journal
articles).
If you still cannot find the doi, find the URL of the home page of the journal on Google.
If you cannot find the home page of the journal, write the reference without a doi or URL.
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Pagination by issue vs. pagination by volume
Each volume of a journal will usually contain more than one issue
i.e., Journal of Style, volume 10, Issues 1-4

Pagination by issue:

page numbering starts from 1 at the beginning of each

issue.
When a journal has pagination by issue, you include the issue number in the reference.

Pagination by volume: page numbering starts from 1 at the beginning of
each volume and continues throughout all the issues of that volume. The page numbers of
individual issues do not start at page 1 (apart from the first issue in a volume).
When a journal has pagination by volume, you do not include the issue number in the
reference.

Journal Articles (APA, 2010, pp. 198-199)
(see explanation of doi and pagination in Notes for Journal Articles above)

Journal article: with doi, pagination by issue
Klimoski, R., & Palmer, S. (1993). The ADA and the hiring process in organizations.
Consulting Psychology Journal: Practice and Research, 45(2), 10-36.
doi:10.1037/1061-4087.45.2.10

Journal article: with doi, pagination by volume
Wilens, T. E., & Biederman, J. (2006). Alcohol, drugs, and attention-deficit/hyperactivity
disorder: A model for the study of addictions in youth. Journal of
Psychopharmacology, 20, 580-588. doi:10.1177/0269881105058776

Journal article: without doi, pagination by issue
Williams, J. (2008). The victims of crime. Sociology Review, 17(4), 30-32. Retrieved from
http://www.philipallan.co.uk/sociologyreview/index.htm
Williams, J. (2008). The victims of crime. Sociology Review, 17(4), 30-32.

Journal article: without doi, pagination by
volume
Arakji, R. Y., & Lang, K. R. (2008). Avatar business value analysis: A method for the
evaluation of business value creation in virtual commerce. Journal of Electronic
Commerce Research, 9, 207-218. Retrieved from http://www.csulb.edu/journals
/jecr/
Arakji, R. Y., & Lang, K. R. (2008). Avatar business value analysis: A method for the
evaluation of business value creation in virtual commerce. Journal of Electronic
Commerce Research, 9, 207-218.
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Websites & online resources
Author, A. A. (Date of publication). Title of Page/Document. Retrieved from URL.
“Do not include retrieval dates unless the source material may change over time (e.g.,
Wikis). (APA, 2010, p. 192)

Web page
National Renewable Energy Laboratory. (2008). Biofuels. Retrieved from http://www.nrel
.gov/learning/re_biofuels.html

Web page: no author
When there is no author for a web page, the title moves to the first position of the
reference entry:
New child vaccine gets funding boost. (2001). Retrieved from http://news.ninemsn
.com.au/health/story_13178.asp

Cite in text the first few words of the reference list entry (usually the title) and the year.
For title of an article, a chapter or a web page use “double quote marks”.
("New Child Vaccine," 2001).

Website: no author, no year, no page number
Heuristic. (n.d.). In Merriam-Webster’s online dictionary (11th ed.). Retrieved from
http://www.m-w.com/dictionary/heuristic
In-text citation may include one of the following:
•
•
•

A paragraph number: (para. 1)
A heading plus a paragraph number within that section: (Discussion section, para. 1)
Or, if the heading is too long, a short title in quotation marks.

Facebook
Username or Group Name. (n.d.). In Facebook [Page type]. Retrieved Month Day, Year,
from http://www.facebook.com/specificpageURL
Nonja. (2010). In Facebook [Fan page]. Retrieved March 17, 2010, from
http://www.facebook.com/pages/Nonja/190010092116
Because content from private or friends-only Facebook pages or profiles is not retrievable
by everyone, if you cite it, it should be treated as personal communication (below).

Newspaper article (including discontinuous pages) (APA, 2010, p.200)
Lawlor, A. (2000, July 20). Phoenician 'find' makes textbooks ancient history. The Courier
Mail, pp. 3,7,10-11.
Heinlein, G. (2007, July 24). Michigan smoking ban takes big step. Detroit News. Retrieved
from http://www.detnews.com

Lecture notes
Bond, T. (2004). ED1401: Childhood and adolescence, week 12 notes. [Word document].
Retrieved from http://learnjcu2004.jcu.edu.au
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Further Examples
Conference Papers (APA, 2010, p. 207)
Proceedings of meetings/symposia published in a book format to be formatted as a book
citation.
Proceedings of meetings/symposia published in journals to be formatted as journal article
citations.
Unpublished conference paper, unpublished paper
Author, A. A. (Year, Month). Title of paper. In E. E. Chairperson (Chair), Title of
symposium. Symposium conducted at the meeting of Organization Name, Location.

Martins, J. R. (2004, April). Working with the terminally ill: An integrated theoretical
model. In J. R. Tunon (Chair), Cooperative health care in the 21st century.
Symposium conducted at the meeting of the American Counseling Association
World Conference, San Diego, CA.
Published conference paper in conference proceedings
Author. (Year). Title of paper. In Editor (first initial, last name) (Ed.) Title of conference
proceedings (page numbers). Place of publication: Publisher. doi:xxx.xxxxxxx

Gibson, C. C. (2005). In S. Allsop (Ed.) Impact of the larger social context on the distance
learner. International Council for Distance Education: One world many voices:
Quality in open and distance learning (pp. 279-282). Chicago: Milton Keynes.

Thesis (APA, 2010, p. 207)
Ward, I. (1998). Sedimentary history of the Pandora wreck and surrounds. Unpublished
master's thesis, James Cook University, Townsville, Australia.

Government publication: Australian Bureau of
Statistics (ABS)
Australian Bureau of Statistics. (1997). Mental health and wellbeing: Profile of adults,
Western Australia (cat. no. 4326.5). Retrieved from AusStats: http://www.abs
.gov.au/ausstats

Government publication: government department
Australia. Department of Health and Aged Care. (2000). National youth suicide prevention
strategy. Retrieved from http://www.health.gov.au/hsdd/mentalhe/sp/nysps
/about.htm

Government report, corporate author (APA, 2010, 205)
U.S. Department of Health and Human Services, National Institutes of Health, National
Heart, Lung, and Blood Institute. (2003). Managing asthma: A guide for schools
(NIH Publication No. 02-2650). Retrieved from http://www.nhlbi.nih.gov/health
/prof/lung/asthma/asth_sch.pdf
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Book Review (APA, 2010, p. 209)
Schatz, B. R. (2000, November 17) Learning by text of context? [Review of the book
Managing change in schools, by J. S. Brown & P. Duguid]. Science, 290, 1304,
doi:10.1126/science.290.5495.1304

Personal communication- letters, email,
interviews, telephone conversation.
Because they don't provide recoverable data, personal communications are not included in
the reference list. Cite in text only.
M. Jones (personal communication, April 4, 2002)
(R. Brown, personal communication, July 23, 2000)

Audiovisual
Diamond, N. (1970). Cracklin' Rosie. On Tap Root Manuscript [DVD]. Universal City, CA:
MCA.
(In text citation, include side and band or track numbers.)
Loi, M-A. (1997). Green tree frogs. [Illustration]. Brisbane, Australia. Queensland
Department of Environment.
Scorsese, M. (Producer), & Lonergan, K. (Writer/Director). (2000). You can count on me
[Motion picture]. United States: Paramount Pictures.

In-text citations
Short quote - less than 40 words (APA, 2010, p.171)
Place quotes of less than 40 words in quotation marks within the text:
This is reflected in the idea that “schools of thought, methodologies and research
techniques reflect their social origins” (Hayes, 1995, p.53)

Long quote – more than 40 words (block quote)
Long quotes, (more than 40 words), put it in a freestanding block of text (block quotation)
without quotation marks. Indent the block about half an inch (1.27 cm)
On the Insert tab, the galleries include items that are designed to coordinate with
the overall look of your document. You can use these galleries to insert tables and
other document building blocks. When you create pictures, charts, or diagrams,
they also coordinate with your current document look. (Gittins, 1998, p. 59)

If your block quotation contains more than one paragraph, indent the first line of each a
further half inch:
On the Insert tab, the galleries include items that are designed to
coordinate with the overall look of your document. You can use these galleries to
insert other document building blocks. When you create pictures, charts, or
diagrams, they also coordinate with your current document look.
You can easily change the formatting of selected text in the document text
by choosing the Quick Styles gallery on the Home tab. Most controls offer a choice
of using the look from the current theme or using a format that you specify
directly. (Gittins, 1998, p. 59)
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In-text citations (continued)
One author
(Griffiths, 1988)
Griffiths (1988) stated that...

Two authors
If a work has two authors, always cite both names every time.
(Griffiths & Clyne, 1988)
Griffiths and Clyne (1988) stated that...

Three, four or five authors
The first time you cite this work in a paragraph:
(Muspratt, Luke & Freebody, 1997)
Muspratt, Luke, Davis and Freebody (1997) found that.

The second and subsequent citations in the same paragraph:
Muspratt et al. (1997) found that…

Six or more authors
Cite only the surname of the first author, followed by et al. and the year for all citations:
Smith et al. (2001) or (Smith et al., 2001)

Long author
The first time you cite this work in a paragraph:
(Australian Bureau of Statistics [ABS], 2000)

All subsequent text citations:
(ABS, 2000)

Some group authors would be written in full every time, e.g., University of Sydney.

No author (APA, 2010, p.176)
If there is no author, use the title. If there is no title, use the first few words of the article.
Do not use ‘Anonymous’ unless the author is actually given as ‘Anonymous’.

For title of an article, a chapter or a web page use “double quote marks”:
(“Evidence Based,” 2010)

For title of a periodical, a book, a brochure, or a report use italics.
(College Bound Seniors, 2010)
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